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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) trunking between Vodafone NL SIP Trunking Service and Avaya IP Office. Vodafone
NL SIP Trunking Service provides PSTN access via a SIP trunk connected to the VVodafone
NL Voice Over Internet Protocol (VolP) network as an alternative to legacy Analogue or
Digital trunks. Vodafone NL is a member of the Avaya DevConnect Service Provider
program.

Vodafone is a member of the Avaya DevConnect Service Provider program. Information in
these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
trunking between Vodafone NL SIP Trunking Service and Avaya IP Office. Vodafone NL SIP
Trunking Service provides PSTN access via a SIP trunk connected to the Vodafone NL network as
an alternative to legacy Analogue or Digital trunks. This approach generally results in lower cost for
customers. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office
500v2 Release 9.0, Avaya Voicemail Embedded, Avaya IP Office Softphone, and Avaya H.323,
digital, and analog endpoints.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Vodafone SIP Trunking service. This configuration (shown in Figure 1) was used to
exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to VVodafone SIP Trunking service.
To verify SIP Trunking interoperability, the following features and functionality were exercised
during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e Incoming PSTN calls to various phone types. Phone types included Avaya H.323, digital,
and analog telephones at the enterprise. All inbound PSTN calls were routed to the
enterprise across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included Avaya H.323, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls to/from the Avaya IP Office Softphone.

e Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free,
emergency and directory assistance.

e Codec G.711Alaw and G.729.

e Caller number/ID presentation.

e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

e DTMF transmission using RFC 2833.

e Voicemail navigation for inbound and outbound calls.

e Telephony features such as hold and resume, transfer, and conference.
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e FAX modes T.38 and G.711 Pass Through.
e Off-net call forwarding.
e Twinning to mobile phones on inbound calls.

2.2. Test Results
Vodafone NL SIP Trunking passed compliance testing.

Items not supported or not tested included the following:
e Inbound toll-free is not supported and not tested in the compliance test.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit
http://support.avaya.com.

For technical support on Vodafone NL SIP Trunking, contact Vodafone Netherlands at
http://www.vodafone.nl/zakelijk/totaal _oplossingen/vast_en_mobiel/
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3. Reference Configuration

Figure 1 illustrates the test configuration. The test configuration shows an enterprise site connected to
the Vodafone NL SIP Trunking Service. Located at the enterprise site is an Avaya IP Office 500 V2.
Endpoints include three Avaya 1608, 9620 (with H.323 firmware) and 1140E IP Telephones, an Avaya
2420 Digital Telephone, an Avaya Analogue Telephone and a fax machine. The site also has a Windows
7 PC running IP Office Manager to configure the IP Office. For security purposes, any public IP
addresses or PSTN routable phone numbers used in the compliance test are not shown in these
Application Notes. Instead, public IP addresses have been obscured and all phone numbers have been
obscured beyond the city code.
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Figure 1: Test Configuration for Avaya IP Office with Vodafone NL SIP Trunking Service
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Avaya IP Office was configured to connect to a Service Provider static IP address. For the purpose
of the compliance test, users dialed a short code of N digits to send digits across the SIP trunk to
Vodafone NL. The short code of 9 was not configured as required from VVodafone and the remaining
N digits are sent in E.164 format.

In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Officer such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the IP Office must be allowed to pass through these devices.
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office 500v2

9.0.2.0 Build 860

Avaya IP Office Manager

9.0.2.0 Build 860

Avaya 11x0 IP Telephone (SIP)

SIP11x0e04.4

Avaya 9620 IP Telephone (H.323)

Avaya one-X® Deskphone Edition 3.22A

Avaya 1608L Telephone (H.323) 1.343A
Avaya IP Office Softphone 3.2.3.20 64770
Avaya Digital Telephone 2420 N/A
Avaya Analog Telephone N/A
Vodafone NL SIP Trunking Service Components

Component Release
Acme Packet Net-Net 4500 SBC SCX6.2.0 MR-11 Patch 4
Cisco CPE/SIP Gateway 29XX
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5. Configure Avaya IP Office

This section describes Avaya IP Office configuration to support connectivity to Vodafone SIP
Trunking service. IP Office is configured through the IP Office Manager PC application. From a PC

running the IP Office Manager application, select Start = Programs = IP Office = Manager to

launch the application. Navigate to File > Open Configuration, select the proper IP Office system
from the pop-up window, and log in with the appropriate credentials. A management window will

appear similar to the one shown in the next section. The appearance of the IP Office Manager can be

customized using the View menu. In the screens presented in this section, the View menu was
configured to show the Navigation pane on the left side, the Group pane in the center, and the
Details pane on the right side. These panes will be referenced throughout the IP Office
configuration. Proper licensing, as well as standard feature configurations that are not directly
related to the interface with the service provider (such as LAN interface to the enterprise site and
Avaya IP Office Softphone support), is assumed to be already in place.

5.1. Verify License Capacity

Navigate to License > SIP Trunk Channels in the Navigation Pane. In the Details Pane, verify
that the License Status is Valid and that the number of Instances is sufficient to support the number
of SIP trunk channels provisioned by VVodafone NL.

| IP Offices | [
=K BOOTP (1) License | Remate Server
Operator (3)
SPIPO2 Feature License Key Instances Status Expiry Date *
81‘1 E}‘Ste(:”) @ Preferred Edition Additional Voice... 2 L 255 Valid Never
-4 Line - i
E-“= Control Unit (4) 3rd Party IP Endpoints 255 Valid Mever
[ Extension (39) Phone Manager Pro (per seat) 9 0 255 Valid Mever
EJ---& User (38) AUDIX Voicemail 3 u 255 Valid Mever
-5 Group (1) VMPro Networked Messaging 255 Valid Mever
U"'g 2"0’_‘( CDOdE 74) VMPro TTS (Scansoft) 255 Valid Never
51 RZ';"&EJ( ) VMPro TTS (Generic) I 255 Valid Never
E]---@ Incoming Call Route (35) IP500 Voice Metworking Channels T M 255 Valid Mever
..... #2) WanPort (0) SIP Trunk Channels 255 | Valid | Never |
----- == Directory (0) IP500 Universal PRI (Additional cha... 255 Valid Mever
5 Time Profile (0) UMS Web Services 255 Valid Never
[#-{i4} Firewall Profile (1) .
Software U de 255 1 Valid N
-l P Route (2) oftware pgra. e a | ever
_____ #m Account Code (0) HAvaya IP endpoints 255 Valid Mever )
..... ‘.; Essential Edition Additional Voice... o - 255 Valid Mever 5
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5.2. LAN2 Settings

In the sample configuration, the LAN2 port was used to connect IP Office to the external internet.
To access the LAN2 settings, first navigate to System - SP IPO2 in the left Navigation Pane where
SP IPO2 is the name of the IP Office. Navigate to the LAN2 = LAN Settings tab in the Details
Pane. The IP Address and IP Mask fields are the public interface of IP Office; Primary Trans. IP
Address is the next hop, usually the default gateway address. All other parameters should be set
according to customer requirements. On completion, click the OK button (not shown).

| IP Offices IE SP IPO2 = vi<l>
’S EJOOTE (2(]3) | System | LANL | LANZ 1 DMS | Voicemail |Telephony Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Cejofir
i Operator
-5 5P IPO2 LAN Settings | VolP | Network Topology |
=537 System (1)
i3y SPIPO2 1P Address 10 0 1 10
BT Line (4)
-2 Control Unit (4) P Mask 255 255 255 0
[+-4 Extension (39) .
. 10 0 1 1
B User (38) Primary Trans. IP Address
-5 Group (1) Firewall Profile [<None> v]
[-8% Short Code (74)
G Service (0) RIP Mode [None v]
-y RAS (1)
EJ--@ Inceming Call Route (35) [] Enable NAT
- WanPort (0) -
- Directory (0) Number Of DHCP IP Addresses |1 -
-7 Time Profile (0) DHCP Mode
(-l Firewall Profile (1) i . i i
-Jll IP Route (2) ) Server () Client () Dialin @ Disabled [ Advanced ]
- Acronnt Code (1

On the VolIP tab in the Details Pane, check the SIP Trunks Enable box to enable the configuration
of SIP trunks. The RTP Port Number Range can be customized to a specific range of receive ports
for the RTP media. Based on this setting, IP Office would request RTP media be sent to a UDP port
in the configurable range for calls using LANZ2. IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to support Quality
of Services policies for both signalling and media. The DSCP field is the value used for media and
the SIG DSCP is the value used for signalling. The specific values used for the compliance test are
shown in the example below. All other parameters should be set according to customer requirements.
On completion, click the OK button (not shown).

IPOffices || System [|¥ SP IPO2 el vl<|>
’S BOOTP (2) flame System | LANL | LANZ |DNS | Voicemail |Telephony Directory Services | System Events | SMTP | SMDR |Twir1r1\ng | VC| 2 |+
e S SPIPO2

= | LAN Setting;| VolP | Network Topology|
-5 System (1) i
9 Line (4) H323 Gatekeeper Enable
- Contrgl Unit (4) Auto-create Extn 7] Auto-create User [7] H323 Remote Extn Enable
-4 Extension (39)
@ User (38) £
.ﬂ Group (1)
@)% Short Code (73] SIP Trunks Enable
4B Service (0)
oy RAS (1) SIP Registrar Enable
- Incoming Call Rou Auto-create Extn/User [C] SIP Rernote Extn Enable
-8 WanPort (0)
- Directory (0) Domain Mame
£ Time Profile (0)
- Firewall Profile (1) upp UDP Port 5060 = Remote UDP Port 5060
[l IP Route (2) -
- Account Code (0) Layer 4 Protocol [T Tep TCP Port 5060 = Remote TCP Port 5060
W License (29) — =
i Tunnel (0) s TLS Port  |5061 = Remote TLS Port | 3061
-§3 User Rights (8) o -
’| Auto Attendant (0) Challenge Expiry Time (secs) 10 =
-8 Location (0) RTP i
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IP Offices IE

SPIPO2

I

v

53

>

=-& BOOTP (2)
{# Operator (3)
-5 5P IPO2
=557 System (1)
T4 Line (4)
-2 Control Unit (4)
[+-4 Extension (39)
ﬁ User (38)
u Group (1)
% Short Code (73)
4B Service (0)
3 RAS ()
e Incoming Call Route (36)
@ WanPort (0)
- Directory (0)
F.“ Time Profile (0)
(@@ Firewall Profile (1)
=-Jll IP Route (2)
- Account Code (0]
W License (29)
@ Tunnel (0)
a 3 User Rights (8)
-l Auto Attendant (0)
F-g ARS (2)
- Location (0)

| System | LANL | LANZ |DNS | Voicemail | Te\ephonyl Directory Service;l System Event;l SMTP | SMDR |Twinning | VCM | CCR | Codec;|

‘ LAN Settings‘ VelP | Network Topology|

RTP
Port Number Range

Minirmum I 48152

Maximum 53246

Port Number Range (NAT)

Minimum 48152

Enable RTCP Monitering on Port 5005

Keepalives

Scope

Initial keepalives

DiffServ Settings

Maximum 53246

[RTp-RTCP

[Enabled v

'] Periodic timeout

30

B8 < DSCP(Hex) BB -

46 +| Dscp 46 =

Video DSCP(Hex) FC |2

Video DSCP 63 <

DSCP Mask (Hex)

DSCP Mask

88

34

SIG DSCP (Hex)

SIG DSCP

m

On the Network Topology tab in the Details Pane, leave the STUN Server Address field as blank
and enter the Public IP Address as 0.0.0.0 for IP Office since the STUN server was not used for this

test. It is important that the Binding Refresh Time is set to the correct value. IP Office sends SIP

OPTIONS messages periodically to determine if the SIP connection is active. The rate at which the
messages are sent is determined by the combination of the Binding Refresh Time (in seconds) set on
the Network Topology tab; see Section 5.10 for more details. Below is a sample configuration. On
completion, click the OK button (not shown).

IP Offices = SP IPO2 e <l
’! gOOTf (233] | System | LANL | LAN2Z | DMS | WVoicemail |Te|ephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM | Lo ([ (1
perator . -
SPIPOZ RIS S | VoIP |, Network Topology ;
Syst
L_is ;;ﬂlpcgz MNetwork Topelegy Discovery
BT Line (4) STUN Server Address STUN Port 3478
(-2 Control Unit (4)
[+ Extension (39) Firewall/NAT Type Open Internet
E-§  User(38)
U"'ﬂ Group (1) Binding Refresh Time (seconds) 60 =
(-8 Short Code (74)
..... @ Service (0) PublicIP Address 0 0 0 0 Run S5TUN Cancel
(ol RAS (1)
E]---@ Incoming Call Route (35) Public Port
----- 2 WanPort (0) <
----- == Directory (0) upP 3060 as
£ Time Profile (0) =
TCp 0 =
(-8 Firewall Profile (1)
=-ll P Route (2) LS 0 =
----- i Account Code (D)
""" S License (29) [] Run STUN on startup
e T 1 a0y
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5.3. System Telephony Settings

Navigate to the Telephony - Telephony tab on the Details Pane. Choose the Companding Law
typical for the enterprise location. For Europe, A-Law is used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfer to the PSTN via the Service
Provider across the SIP trunk. On completion, click the OK button (not shown).

IP Offices

| I

SP IPO2

i)

o

=& BOOTP (2)
-4 Operator (3)
=% SPIPO2

%57 System (1)

i %27 SPIPO2

-7 Line (@)

+ = Contrel Unit (4)

-4 Extension (39)

B User (38)

-5 Group (1)

+--@% Short Code (74)

4 Service (0)

-y RAS (1)

+e Incoming Call Route (35)
48 WanPort (0)
i~ Directory (0)
L7 Time Profile (0)
1@ Firewall Profile (1)
+II IP Route (2)
i Account Code (0)
% License (29)
il Tunnel (0)
-y User Rights (8)
@ Auto Attendant (0)
B¢ ARS (2)

o

| System | LAMN1 | LANZ | DNS |Vo|cema\| |TE|EF"10")“ Directory Services | System F_ventsl SMTP | SMDR |Twmn|ng |VCM | CCR | Codecs|

Telephony | Park&PagEl Tone;&Mu;icl Ring Tonesl SM

[ catitog [Tur |

Analogue Extensions

Default Outside Call Sequence
Default Inside Call Sequence

Default Ring Back Sequence

Dial Delay Time (secs)

Dial Delay Count

Default Mo Answer Time (secs)
Hold Timeout (secs)

Park Timeout (secs)

Ring Delay (secs)

Restrict Analogue Extension Ringer Voltage

n

0

15

660

300

5

A\ D (Tl (T Tl (T

INormaI

Ing Typel

Ing Typel2

b

Companding Law

Switch Line
) U-Law U-Law Line
@ A-Law @ A-Law Line

-

m

[ DsS Status
Auto Hold
Dial By Mame

Show Account Code

ID Inhibit Off-Switch Forward/Transfer I

[ Restrict Metwork Interconnect

[ Diron Evternal Onbe Imnrmmntn Conference

5.4. System Twinning Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of

other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the System->Twinning tab. The second parameter is the
Send Caller 1D parameter on the SIP Line form (shown in Section 5.6.2).

For the compliance testing, the Send original calling party information for Mobile Twinning as
shown below was unchecked. This setting allows Send Caller 1D parameter that was set to None in
Section 5.6.2 to be used. IP Office will send the following in the “From” header:
e On calls from an internal extension to a twinned phone, IP Office sends Calling Party
Number of the originating extension.
e On calls from the PSTN to a twinned phone, IP Office sends Calling Party Number of the
originating twinned phone.

ID Send original calling party information for Mobile Twinning I

Mobile Twinning

Calling party informaticn for

IP Offices |EE SP IPO2 =
2R 800TP @ | System | LANL | LAN2 | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning |

EIE

5.5. System Codec Settings

Navigate to the Codecs tab. The Available Codecs box indicates all audio codecs available on the
system. Highlight codecs in the Unused box that are to be used by the service and click on the right
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arrows to move them to the Selected box. Highlight codecs in the Selected box that are not to be
used and click on the left arrows to move them to the Unused box. Highlight codecs in the Selected
box and use the up and down arrows to change the priority. On completion, click the OK button (not
shown).

IP Offices IE SP IPO2 v | <

El K BOOTP (2

55 Operator @) System | LANL [ LAN2 | DNS [ Voicemail | Telephony | Directory Services [ System Events | sMTP [ sMDR [ Twinning [vem [ ccr | Codecs
¢ Operator

SPIPO2 RFC2833 Default Payload 101
%2y Systern (1)
= SPIPO2 Available Codecs Default Codec Selection

17 Line (4) Unused Selected

#-<2 Contral Unit (4) V] G.711 ULAW 64K 33> G711 ALAW 64K

::? S“e”gg” &9 7] G711 ALAW 64K G.729() 8K CS-ACELP
& GSE'( ) V] G722 64K G711 ULAW 64K

* roup (1] 7] .729(a) 8K CS-ACELP 5.722 64K

+-@% Short Code (74)

@ Service (1) V| 67231 6K3 MP-MLQ P G.7231 6K3 MP-MLQ
2ol RAS (1)
+® Inceming Call Route (35)
~#f WanPort [0)
-4 Directory (0) ann

3:_}“- Time Profile {07

Note: During the testing, all available codecs were selected to test the codec negotiation between IP
Office and the Vodafone NL network.

5.6. Administer SIP Lines

SIP lines are needed to establish the SIP connections between IP Office and the Vodafone NL SIP
Trunking service. Two SIP lines are required, one is for the Vodafone Office Voice (VoV) service,
and the other is for their Corporate Net over IP (CNolP) service. The recommended method for
configuring a SIP Line is to use the template associated with these Application Notes. The template
is an .xml file that can be used by IP Office Manager to create a SIP Line. Follow the steps in
Section 5.6.1 to create the SIP Line from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses.

SIP Credentials (if applicable).

SIP URI entries.

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.6.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually, in order to do so right-click Line in the
Navigation Pane and select New = SIP Line. Then, follow the steps outlined in Section 5.6.2.
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5.6.1. Create SIP Line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to NL_Vodafone_SIPTrunk.xml. The file name is important in locating the
proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK.

"/ IP Office Manager Preferences

Preferences | Directories | Discovery| Visual Preferences | Security I ‘u’alidation|

Multiline Tabs
Enable Template Options

(-7 |l

OK l l Cancel

Help l

3. Import the template into IP Office Manager. From IP Office Manager, select Tools >
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down

menus in Step 5. The default template location is C:\Program Files\Avaya\lP

Office\Manager\Templates.

f Avaya IP Office Manager SP IPO2 [9.0.200.860] [Administrator(Administrator)]

File Edit View | Tools | Help

SpIPO2 Extension Renumber...
Line R ber... — X
IP Offices e renambE = SIP Line
Connect To...
a BOOTP (2) Export bType SIP Line SIP URI| W)
“ Operatar (3)
o= SPIPO2 SCN Service User Management Line Number
- System (1) -
_____ = Busy en Held Validation ITSP Domain Name
""" & E;t”t":_'l U’E;t MSN Cenfiguration
----- y ension
..... 1 Usere) Print Button Labels
----- ﬂ Group (1) Import Templates in Manager Prefix
----- X Short Code (75T
..... @ Service (0) Maticnal Prefix
..... @; R_AS (‘l)
----- €9 Incoming Call Rov Country Code
----- 8 WanPort (0)
..... ;@f: Directory (0) International Prefix
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window (not

shown) will appear stating success or failure. Click OK (not shown) to continue. If

preferred, this step may be skipped if the template file is copied directly to the IP Office

templ

ate directory.

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New = New SIP Trunk From Template.

IP Offices ‘ Line = SIP Line - Line 17 gk -@ X v <>
R e00TP (2) + | LineMNumber LineType Line SubType SIP Line Transport |SIP URI|VolP | T38 Fax|SIP Credentials
Operator (3) 17 SIP Line -
SPIPO2 = : 17 =

g Syste L] New g H323 Line

""" e, cut — P DECT Line

----- “r Contl .

..... & Eder Copy Ctrl+C SIP Line

..... % User Paste CtrleV SM Line

..... G .

,,,,, 9o Shor| 7 Delete Ctrl+ Del SIP DECT Line

..... B servi Validate MNew SIP Trunk From Template 0 =

""" o RAS Connect To... Ctrl+T

..... @ Inco Country Code

..... £ Wan Mew from Template (Binary)

;‘ﬂ: _Drii;:: Show In Groups International Prefix 00

""" @ Firew Customize Columns... send CallerID ’None ']

----- 1P Roawey

..... & Account Code (0) Association Method ’By Source IP address v]

----- % License (29)

----- & Tunnel (0}

----- §5 User Rights (3)

----- i Auto Attendant (07

..... "¢ ARS (2)

----- &8 Location (0)
-4 SPIPO2 E aeecnc T

-ap Systern (1) J jll k

----- 9 Line (4)

----- S Conteal lnit (477 -
. T * = 3 " [ b biclp
Ready |—T

5. In the subsequent Template Type Selection pop-up window, select Netherlands from the
Country pull-down menu and select Vodafone from the Service Provider pull-down menu
as shown below. These values correspond to parts of the file name
(NL_Vodafone_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to finish
creating the trunk.

™ Template Type Selection El (=] @
Locale United States (LIS English)
Country [ Methedands - ]
Service Provider ["u’udafune v] [ Display Al
Create new SIF Tunk | | Cancsl |

13 0f 32
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5.6.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the

Group Pane and select New - SIP Line. On the SIP Line tab in the Details Pane, configure the
parameters as shown below:

e ITSP Domain Name field should remain blank as VVodafone NL SIP Trunking have not
provided a Domain Name.

e Set Send Caller ID to None as it is only required if the box labeled Send original calling
party information for Mobile Twinning is unchecked in Section 5.4.

e Ensure the In Service box is checked.

e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.

e Default values may be used for all other parameters.

The area of the screen entitled REFER Support is used to enable/disable SIP REFER for call
transfers. The default values of “Auto” for Incoming and Outgoing effectively disable use of SIP
REFER and use Re-Invite for the call transfer. In the compliance test, only Re-Invite method was
successfully tested to transfer a call between a PSTN phone and an enterprise phone to a second
PSTN phone.

On completion, click the OK button (not shown).

IP Offices | SIP Line - Line 17 ok -9 X[ v

= R BOOTP @) SIP Line |Transport| SIP URI|VolP | 738 Fax| SIP Credentials|

47 Operator (3)

' SPIPO2

t ' System (1)

BT Line (4)
;18

", 19

<% Control Unit (4)

-4 Extension (39)

@ User(38)

-3 Group (1)

- @% Short Code (74)

- Service (0)

-y RAS (1)

@ Incoming Call Route (35)

2 WanPort (0)

@ Directory (0]
~£7 Time Profile (0)
@ Firewall Profile (1)
-Jill IP Route (2)
-l Account Code (0)
W License (29)
-l Tunnel (0)
-3 User Rights (8)
~{jll Auto Attendant (0)
- ARS (2)

& Location (0)

Line Number 17 =

ITSP Domain Mame In Service

URI Type [si -

Prefix Check O0%

National Prefix 0 Call Routing Method IReque;t URI VI

Originator number for

Country Code forwarded and twinning calls

International Prefix 00 hame Priority ISystem Default 'l

Send Caller ID | [None v]I Caller ID from From header

Association Method [By Source IP address v] Send From In Clear =

User-Agent and Server
Headers

Service Busy Response |485 - Busy Here 'I

Action on CAC Location Limit lAIIoonicEmEﬂ vl

REFER Support

Incoming [Auto ']

Outgeing [Auto v]

m

KP; Reviewed:
SPOC 6/3/2014

Solution & Interoperability Test Lab Application Notes 14 of 32
©2014 Avaya Inc. All Rights Reserved. Vodafone-1PO9




Select the Transport tab and set the following:
e Set ITSP Proxy Address to the IP address of the VoV service on the Vodafone NL SIP proxy.
e Set Layer 4 Protocol to UDP.

e Set Send Port and Listen Port to 5060.
e Set Use Network Topology Info to None.

On completion, click the OK button (not shown).

IP Offices

£

SIP Line - Line 17*

e -9 X | v

@R BOOTP (2)
---‘5 Operator (3]
¥ SPIPO2
H-457 Systern (1)
Line (4)

-2 Contrel Unit (4)
H-4 Extension (39)
§ User(3m)
5§ Group (1)

SIP Line| Transport SIP URI|VelP | T38 Fax|SIP Credentials

Network Configuration

ITSP Proxy Address | scanocuox229 |

Calls Route via Registrar

Layer 4 Protocol [iioP +|  Sendpor [5060 =
Use Metwork Topology Info lNone v] Listen Port 5060 5
Explicit DNS Server(s) 0 0 0 0 1]

(- 8% Short Code (74)

After the SIP line parameters are defined, each SIP URI that IP Office will accept on this line must be
created. To create a SIP URI entry, first select the SIP URI tab. Click the Add button and the New

Channel area will appear at the bottom of the pane.
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For the compliance test, two SIP URI entries were created for the VoV SIP line. One entry that matched
any number assigned to an IP Office user. The entry was created with the parameters shown below.

Set Local URI to *, This setting allows all calls with numbers defined in Incoming Call
Routing as shown in Section 5.9.

For Registration, select 0: <None> from the pull-down menu since this configuration does not
use SIP registration.

Associate this line with an incoming line group by entering a line group number in the Incoming
Group field. This line group number will be used in defining incoming call routes for this line.
Similarly, associate the line to an outgoing line group using the Outgoing Group field. The
outgoing line group number is used in defining short codes for routing outbound traffic to this
line. For the compliance test, a new incoming and outgoing group 17 was defined that was
associated to a single line (line 17).

Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using this
SIP URI pattern.

On completion, click the OK button.

Edit Channel

Wia <Mone>
Lacal URI | i -
Contact -

Display Mame -

PAl -

Registration [[.'l: <Maone> -

Incoming Group 17

Outgeoing Group 17

Max Calls per Channel 10 =

The second SIP URI entry was used for outgoing calls and used to send caller ID configured in SIP
Name in the User = SIP section of Section 5.8. On completion, click the OK button.

Edit Channel

Wia <Mone=
Local R -
Contact -
Display Mame -
PAI -
Registration [U: <Mones> -
Incoming Group 17
Outgeoing Group 17
Max Calls per Channel 10 =
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Repeat the process to define a SIP line for Corporate Net over IP (CNolP). Select the Transport tab and
set the following:
e Set ITSP Proxy Address to the IP address of the CNolP service on the Vodafone NL SIP proxy.

e Set Layer 4 Protocol to UDP.
e Set Send Port and Listen Port to 5060.

On completion, click the OK button (screenshots not shown). Note: In the testing, line 17 was used for
VoV and line 18 was used for CNolP.

Select the VVoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the parameters
as shown below:
e Select Custom in the Codec Selection drop down menu to specify the preferred codecs.
e Highlight codecs in the Unused box that are to be used on this line and click on the right arrows
to move them to the Selected box.
e Highlight codecs in the Selected box that are not to be used and click on the left arrows to move
them to the Unused box.

e Highlight codecs in the Selected box and use the up and down arrows to change the priority order
of the offered codecs, for testing with Vodafone NL this was G.711 ALAW 64K followed by
G.729(a) 8K CS-ACELP.

e Select T38 Fallback in the Fax Transport Support drop down menu to allow T.38 fax
operation.

e Select RFC2833 in the DTMF Support drop down menu. This directs IP Office to send DTMF
tones using RTP events messages as defined in RFC2833.

e Uncheck the VVolP Silence Suppression box.

e Check the Re-invite Supported box, to allow for codec re-negotiation in cases where the target
of the incoming call or transfer does not support the codec originally negotiated on the trunk.

Default values may be used for all other parameters.

On completion, click the OK button (not shown).

IP Offices | b SIP Line - Line 17* e - X v

=K BOOTP (2) SIP Line | Transport| SIP URI VoIP  |T38 Fax|SIP Credentials
-7 Operator (3)
-2y 5P IPO2 [T] VolP Silence Suppression

Allow Direct Media Path

Codec Selection ICustom 'J Re-invite Supported
Unused Selected
[[] Codec Lockdown
- G711 ALAW 64K Po G711 ULAW 64K
112 Control Unit (4) 5,722 B4K (G.729(a) 8K CS-ACELP [] PRACK/100rel Supported
+-48 Extension (39) G.723.1 6K3 MP-MLQ
£ : User (38) Force direct media with phones
3@ Group (1)
+1-83 Short Code (74) cx< 7] G711 Fax ECAN
-G Service (0)
ol RAS (1)

+@ Incoming Call Route (35)
4@ WanPort (0)

! Time Profile (0)
Firewall Profile (1) e
+n 1P Route (2) Fax Transport Support IT38 Fallback ']
- Account Code (D)
% License (29)

Location lCIoud ']

4475 User Rights (8)
1@ Auto Attendant (0) DTMF Support [Recasaz -]
- ARS (2)

i Location (0)
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Select the T.38 Fax tab to set the T.38 parameters for the line. Un-check the Use Default VValues box
and select 1 from the T38 Fax Version drop down menu. Set the Max Bit Rate (bps) to 14400. All
other field may retain their default values. On completion, click the OK button (not shown).

| IP Offices = SIP Line - Line 17* e -8 % v
=K BOOTP (2) [5IP Line| Transport| SIP URI|velp T3 Faxi|sip Credentials
1147 Operator (3)
=53 SPIPO2 T35 Fax Version 1 -
= System (1) Scan Line Fix-up
=14 Line (4) Transport UDPTL
P, 17 TFOP Enhancement
H , 13 Redundancy
! || Disable T30 ECM
" 19 Low Speed 0 =
P 20 ["] Disable EFlags For First DIS
<= Contrel Unit (4] High 5peed 0 : i
+ & Edension (39) [7] Disable T30 MR Compression
+ = User (38) TCF Method Trans TCF b4 [] NSF Override
+ ﬂ Group (1) S =
+1-8X Short Code (74) Max Bit Rate (bps) (14400 - s
- Service (0) m
+ ol RAS (1) EFlag Start Timer (msecs) 2600 = .
] e Incoming Call Route (35) =
i @ WanPort (0) EFlag Stop Timer (msecs) 2300 =
@= Directory (0] ; 150 z
F£7) Time Profile (0) Tx Metwork Timeout (secs) =
#1-) Firewall Profile (1)

5.7. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, right-click Short
Code in the Navigation Pane and select New. On the Short Code tab in the Details Pane, configure the
parameters as shown below.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon.

e The example shows 00N; which will be used for international call in Netherlands and invoked
when the user dials 00 followed by an international number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to +N which will insert the E.164 number prefixed with a + in the
Request URI and To headers in the outgoing SIP INVITE message.

e Set the Line Group ID to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.6.2.

On completion, click the OK button (not shown).

IP Offices | Short Code = 00N Dial =B X

& eooTP 2) Code Telephone Mumber o Short Code

Operator (3) BXT0NE N

SPIPO2 TINE N Code 00N

System (1) * n "
7 Line (4) 50007 " MAINTENANCE Feature (ot -
< Control Unit (4) ox-oin;  N'L”

A& Extension (39) PHO2N: N2 Telephone Mumber | +N

% ESE’ (z8) #%-DSSN ":[0)151/ERR - "N Line Group D 7 -

ox SI':ELI'ItpCCol?:Ie o OX*SDN  ";[0}151/ERR - "N

@ service () OXSKN  [0)IS1/ERR - "N Lacale [ . I
.\g,; RAS (1) Force Account Code [

Short codes are also used for routing of national fixed and mobile calls, as well as VPN calls for CNolP.
National fixed line calls use the SIP line established for the Vodafone Office Voice (VoV) service.
National mobile and VPN calls use the SIP line established for the Corporate Net over IP (CNolP). An
example for VPN calls is shown below.
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e The example of a VPN call shows 7N; which will be invoked when the user dials a four digit

VPN number.

e Set Telephone Number to 7N which leaves the number unchanged.

e Set the Line Group ID to the outgoing line group number for CNolP defined on the SIP URI tab

on the SIP Line in Section 5.6.2.
e Set other parameters as shown in the previous example.

IP Offices | Short Code = 7N;: Dial et - X
R BOOTP (2) Code Telephone Number i Short Code
70" NE N
TIENE B Code N
PREN M
TN 7N Feature [DIE| ~
= Control Unit (4) " "
& Extension (39) RN 11129N" @avayalab.com:5060 Telephone Number | 7N
§ User(s) #xolN; 1N )
: ﬂ Group (1) RITN; N"@avayalab.corm:5060" = Line Group ID 18 M
9% Short Code (74) BXOEN;  N'@64.199.64.220:5060" Locale [ =
""" D senvice ) PX00N;  N"®204.13143.26:6070"
..... RAS (13 - .. Force Account Code [

An example for mobile calls is shown below.

e The example of a mobile call shows 06N; which will be invoked when the user dials mobile
numbers starting with 06.

e Set Telephone Number to O6N.

e Set the Line Group ID to the outgoing line group number for CNolP defined on the SIP URI tab

on the SIP Line in Section 5.6.2.
e Set other parameters as shown in the previous examples.

IP Offices | Short Code = 06N;: Dial i X
8 BOOTP (2) Code Telephone Mumber “|1| short Code
i~gie Operator (3) X0 NE N
BTINE N Code 06N;
System (1) . "
Line () 92°9000" "MAINTENANCE Feature [Dial -
-2 Control Unit (4) ®OIN, N1
-4 Bxtension (39) @%03N; 03N Telephone Number | 06N
4 User ) i
33 Group (1) oo o Line Group ID 18 -
g zzmgge a4 BX1N;  1N"@204.13.143.26:6070" Locale [ »
oL RAS (1) 6N M Force Account Code [7]
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5.

8. User

Configure the SIP parameters for each User that will be placing and receiving calls via the SIP lines

defined in Section 5.6. To configure these settings, first navigate to User in the Navigation Pane. Select

the User tab if any changes are required. Changes are not normally required where only the newly

established SIP line is to be used for an existing User. In the example below, the User is configured to
use IP Office Softphone.
e Change the Name of the User if required, this will be used for login to the IP Office Softphone.

e Select Teleworker User from the Profile drop down menu.
e Check the Enable Softphone box to support IP Office Softphone.

IP Offices | User = Extn235: 235 eh - X v <
-
’,‘ BOOTP (2) hlame Ditersiop User Voicemail | DMD | Shart Codesl Source Mumbers | Telephony | Forwarding | DialIn IVoice Record | 1
i* Operator 3) % Edn210 210
S5 SPIPO2 § b 1 Name I Extn235 I
3 System (1)
“F4 Line (4) i Exn212 212 Password ~ FE
<= Contrel Unit (4] & Extn213 213
< Extension (39) i Exn214 214 Confirm Password T
~ @ User (38) § ean2is 215
Account Status Enabled
2 ?g°‘:tPCaL o § Exn2i6 216 l
= szvi(a?oje i EBxtn217 17 Full Name
-l RAS (1) § Ben2is 28 Extension 5
@ Incoming Call Route (35) a Extn219 219
@ WanPort (0] & Extn220 220 Email Address
o Directory (0] § Eanz2i 21
1) Time Profile (0) 1 oanz2 o Locale [
@ Firewall Profile (1)
KA 1P Route (2) § Exn223 223 Priarity [5
.4 Account Code (0] B Extnad 224 Systerm Phone Riht [
& License (29) frExtn225 225 ystem Phone Rights one
?‘ Janne ©) ® i Exn226 226 Profile |[Teleworkeruser |
i User Rights L
-l Auto Attendant (0) g:z"i; i; 3 |5 Receptionist
g ARS (2) n.
&% Location (0) § Ban2ze 229 Enable Softphone
&HEKtnEBO 230 Enable one-X Portal Services
| Enable one-X TeleCommuter
f-Extn231 231
fExtn232 232
- Extna33 233 Enable Remote Worker
i Extn234 234 [ Enable Flare
W Enahle Mnhile ValD Client

Select the SIP (not shown) tab in the Details Pane. To reach the SIP tab, click the right arrow on the
right hand side of the Details Pane until the SIP tab appears. The values entered for the SIP Name and
Contact fields are used as the user part of the SIP URI in the From header for outgoing SIP trunk calls.
These allow matching of the SIP URI for incoming calls without having to enter this number as an
explicit SIP URI for the SIP line (Section 5.6). As such, these fields should be set to one of the DDI
numbers assigned to the enterprise from Vodafone NL.

In the test, the digits received in the SIP URI were in national format. The received digits were
provisioned for the User, these have been obscured in the screenshot below. The SIP Display Name
(Alias) parameter can optionally be configured with a descriptive name. On completion, click the OK
button (not shown). Note: The Contact field must be in E.164 format for the caller ID on the called
phone to display properly.

+@% Short Code (741

[ Anonymous

IP Offices \ User 7 Extn235: 235° EREIEIAREE
's BOOTP 2) Mame E ‘ Menu Programming | Mobility | Group Membership | Anﬂouncements‘ sIp |Persona\ Directory‘
-~+{% Qperator (3) a Extn210 270
=0 SPIPO2 a Extn211 71 SIP Mame nAnnnann
system (1 § Ean212 12
17 Line (4) " SIP Display Name (Alias) | Extn235
- Cantrol Unit {4) § Ban213 213
4 Extension (39) § Bin21s 214 Contact nannnnnn
@ User(38) § EBnas 215
-4l Group 1) § EBan2i6 216
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5.9. Incoming Call Route

An incoming call route maps an inbound DDI or VPN number on a specific line to an internal extension.
The line is dependent on whether the call is VVodafone Office Voice (VoV) or Corporate Net Over IP
(CNolP). To create an incoming call route for VoV, right-click Incoming Call Routes in the Navigation
Pane and select New. On the Standard tab of the Details Pane, enter the parameters as shown below:

e Set the Bearer Capacity to Any Voice.

e Set the Line Group ID to the incoming line group of the SIP line for VoV defined in Section

e Set the Incoming Number to the incoming number that this route should match on. Matching is
right to left.
e Default values can be used for all other fields.
IP Offices | Incoming Call Route T 17 038C——15° & - X v | <
R BOOTP(2) Line GroupID' Incoming Number Destination it m
4 Operator (3) @0 19 230 Extn230
5% P1P02 ®o 200 Main
{“‘ E;,fstemrr; o eg Dizlln Bearer Capability |Any Voice v|
£ Line
- Control Unit (4) @7 [ ¢ 5 | 235 Extn235 Line GroupID 17 -
& Dxtension (39) @u 03 6 236 Extn236
5“ User (38) @u 03 7 EMEZ3 Incoming Number 038nnnnn33
™ S;E:tpcﬂoilje e} el? 03 2 232 Bxtnd3d Incoming 5ub Address
B Senvice (0) @u 03 1 201 Extn201
o RAS @17 03 0 230 Bxtn230 =[|[| ncoming cL1
=] @u 03 3 233 Bxtn233 Locale | '|
&g WanPort (0] ®u 03 4 234 Extn234
7% Directory (0 @ 64 2 231 Btn231 Priority [1- Low -]
-5 17 Time Profile (0) K
@ Firewall Profile (1) [F3E] o4 0 Voicehail Tag
~fll 1P Route (2) QP 64 3 FNEOD
- Account Code (0 018 64 7 230 Extn230 Hold Music Source |System Source v|
R License (29) D18 64 6 229 Extn229

On the Destinations tab, select the destination extension from the pull-down menu of the Destination
field. On completion, click the OK button (not shown). In this example, incoming calls to the test DDI
number on line 17 are routed to extension 235.

IP Offices | Incoming Call Route 3 17 038C——135" o - ¥ | v | <
K BOOTP 2) Line Group ID  Incoming Number Destination * | [iStandard:| Woice Recording | Destinations
4 Operator (3)
SPpIPOE gg 1 iég ;@1230 TimeProfile Destination Fallback Extension
amn
+% System (1) @0 Diall » | Defautt Value |35 Extn23s I I-1 -
7 Line (@) 1alin
‘= Control Unit (4] @17 038335 235 Extn233
i Extension (39) Q17 JEs — 1 236 Extn236

5.10. SIP Options

IP Office sends SIP OPTIONS messages periodically to determine if the SIP connection is active.
The rate at which the messages are sent is determined by the combination of the Binding Refresh
Time (in seconds) set on the Network Topology tab in Section 5.2 and the
SIP_OPTIONS_PERIOD parameter (in minutes) that can be set on the Source Number tab of the
noUser user. The OPTIONS period is determined in the following manner:
e Ifno SIP_OPTIONS_PERIOD parameter is defined and the Binding Refresh Time is 0,
then the default value of 300 seconds is used.
e To establish a period less than 300 seconds, do not define a SIP_OPTIONS_PERIOD
parameter and set the Binding Refresh Time to a value less than 300 seconds. The
OPTIONS message period will be equal to the Binding Refresh Time.
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e To establish a period greater than 300 seconds, a SIP_OPTIONS_PERIOD parameter
must be defined. The Binding Refresh Time must be set to a value greater than 300
seconds. The OPTIONS message period will be the smaller of the Binding Refresh Time
and the SIP_OPTIONS_PERIOD.

To configure the SIP_OPTIONS_PERIOD parameter, navigate to User = noUser in the
Navigation / Group Panes. Select the Source Numbers tab in the Details Pane. Click the Add button
(not shown). At the bottom of the Details Pane, the Source Number field will appear. Enter

SIP_OPTIONS_PERIOD=X, where X is the desired value in minutes. Click OK.

IP Offices | User = NoUser: == I AR AR

‘s E]OOTE (2(13] ;Iame fctencion | User IVoicemaiI | DD | Short Codes| Source Numbers | Telephony | Forwarding | Dial In |V: -H A
# Operator Extn2l6 216

5P Izoi " § Eextnni7 217 Source Number Add...
%% System

..... T Line () § EBxdn2ig 218

----- “= Control Unit (4) § Ban219 219 femove

----- 8 Extension (39) a Extn220 220 Edit

""" § Userm) § Ban221 Pyl i

..... G

..... B orcotey |1 Bz

_____ @ service 0) § Ean2z 223

..... ol RAS (1) § Exn2ze 224

----- @ Incoming Call Route (3€ §EBxtn225 225

""" &) WanPort (0) § extn226 226

..... ;ﬁf._‘ 1[1ne(t§l’)‘f§?] o a,., Extn227 2727

-5 Time Profile

----- @ Firewall Profile (1) i Extn228 8

..... Hl P Route (2) § Bdn229 229

----- B Account Code (0) ﬂ"ExtnBU 230

----- % License (29) f-Bdn231 231 E

""" ?E Tunnel (0) frEan222 232

----- 3 User Rights (8)

i Extn233 233 Mew S Mumb

----- 88 Auto Attendant @) | &M EysouTcs Humber

----- ¢ ARS (2) ErBxtn234 B 5 Mumb SIP_OPTIONS_PERIOD=7
..... & Location (0) §rEan23s 235 ouree Fumber - - B

§rExtn236 2% anee
rg RemoteManager -

The SIP_OPTIONS_PERIOD parameter will appear in the list of Source Numbers as shown
below. Note that for the compliance test, an OPTIONS period of 1 minute was desired. The

Binding Refresh Time was set to 60 seconds (1 minute) in Section 5.2. The
SIP_OPTIONS_PERIOD was not created and used at all. This section was just mentioned for
those who wish to configure the IP Office sending out the OPTIONS greater than 300 seconds.

IP Offices | User 7 NoUser: * e - X v <!>
R Elggr-arfo(rz(]ﬂ :a::nzlﬁ EE);:aension | User |Voicemai| | DD | Short Codes| Source Numbers | Telephony | Forwarding | Dial In |V: )
' SPIPO2 § Exn217 217 Source Number Add...
! System (1)
A Line () § Bdn218 218 SIP_OPTIONS_PERIOD=7
Control Unit (4) § Exn219 219 ESmovs
Extension (39) a Extn220 220 i
User (38) § Bdnonl 271 Edit...
5.11. Save Configuration
Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. Vodafone NL SIP Trunking Configuration

Vodafone NL is responsible for the configuration of Vodafone SIP Trunking service. The customer
will need to provide the IP address used to reach IP Office at the enterprise. Vodafone will provide
the customer the necessary information to configure IP Office SIP connection to VVodafone. The
provided information from Vodafone includes:

e [P address of the Vodafone SIP proxy.

e Supported codecs.

e DDI numbers.

e [P addresses and port numbers used for signaling or media through any security devices.

7. Verification Steps

The following steps may be used to verify the configuration:
e Use the IP Office System Status application to verify the state of the SIP connection. Launch
the application from Start = Programs > IP Office = System Status on the PC where IP
Office Manager is installed. Select the SIP line of interest from the left pane. On the Status
tab in the right pane, verify that the Current State is Idle for each channel (assuming no
active calls at present time).

AVAYA IP Office System Status

Help Snapshot LogOff Exit About

Status  tilization Summary Alarms

+ 1

SIP Trunk Summary
Peer Domain Mame: sipy /a2, E=1.229
Resolved Address: (3 — el
Line Mumber: 17
Mumber of Administered Channels: 0
Mumber of Channels in Use: i}
Administered Compression: G711A, G729 4
Silence Suppression: Off
Layer 4 Protocol: [W]na]
SIF Trunk Channel Licenses: Unlimited . -
SIF Trunk Channel Licenses in Use: o

SIP Device Features:

Chan... Curr... Timein Remote Co... Conn... Caller Other Party Direc... Round Recei... Rece... Tran... Tran...

State  Media ... ID or... on Call Trip ...
Idle |00:0...

Idie |00:0... (
Ide [00:0... |
Ide |00:0...
Idle |00:0...
Ide |00:0...
Ide |00:0...
Idle |00:0... >

OO sl | O | | | L D
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

AVAyA IP Office System Status

Help Snapshot LogOff Exit About

Status  Utilization Summary Alarms

Alarms for Line: 17 SIP sip://62. 1229

e Of Error Occurrences Error Description

e Verify that a phone connected to PSTN can successfully place a call to the IP Office with
two-way audio.

e Verify that a phone connected to IP Office can successfully place a call to the PSTN with
two-way audio.

e Using a network sniffing tool e.g. Wireshark to monitor the SIP signalling between the
enterprise and VVodafone. The sniffer traces are captured at the public interface of IP Office.

Following screenshots show an example incoming call from VVodafone to the enterprise.
e Incoming INVITE request from VVodafone.

INVITE sip:038xxxxx@10.0.1.10:5060 SIP/2.0

Via: SIP/2.0/UDP 61.xxx.xxx.229:5060;branch=z9hG4bK28BB3811FA
From: <sip:001613xxxxx580@61.xxx.xxx.229>;tag=BEDDA55C-83F
To: <sip:038xxxxx@10.0.1.10>

Date: Wed, 23 Apr 2014 18:04:20 GMT

Call-ID: 87661A76-CA4811E3-A7C4F60A-331B0F48@61.xxx.xxx.229
Supported: timer, resource-priority,sdp-anat

Min-SE: 1800

User—-Agent: Vodafone-NL-SIP-Gateway-V1.1

Allow: INVITE, OPTIONS, BYE, CANCEL, ACK, PRACK, REGISTER
CSeqg: 101 INVITE

Timestamp: 1398276260

Contact: <sip:001613xxxxx580@61.xxx.xxx.229:5060>

Expires: 180

Allow-Events: telephone-event

Max-Forwards: 67

P-Preferred-Identity: <sip:001613xxxxx58@61.xxx.xxx.229>
Session-Expires: 1800

Content-Type: application/sdp

Content-Disposition: session;handling=required
Content-Length: 287

v=0

o=CiscoSystemsSIP-GW-UserAgent 4448 748 IN IP4 61.xxx.xxx.229
s=SIP Call

c=IN IP4 61.xXxX.xXxXX.229

t=0 0

m=audio 23834 RTP/AVP 8 18 101
c=IN IP4 61.xxx.xxx.229
a=rtpmap:8 PCMA/8000
a=rtpmap:18 G729/8000
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a=fmtp:18 annexb=no
a=rtpmap:101 telephone-event/8000
a=fmtp:101 0-15

e Outgoing 2000K response from the enterprise.

SIP/2.0 200 OK

Via: SIP/2.0/UDP 61.xxxX.xxx.229:5060;branch=z9hG4bK28BB3811FA
From: <sip:001613xxxxx580@61.xxx.xxx.229>;tag=BEDDA55C-83F
Call-ID: 87661A76-CA4811E3-A7C4F60A-331B0F48Q@61.xxxX.xxXx.229
CSeqg: 101 INVITE

Contact: "Extn234" <sip:038xxxxx@10.0.1.10:5060; transport=udp>
Allow: INVITE,ACK,CANCEL,OPTIONS,BYE, INFO,NOTIFY

Supported: timer

Server: IP Office 9.0.2.0 build 860

Min-SE: 1800

Require: timer

Session-Expires: 1800;refresher=uac

To: <sip:038xxxxx@10.0.1.10>;tag=bd8f6b8208b0e3d0
Content-Type: application/sdp

Content-Length: 198

v=0

o=UserA 1819019355 3393600283 IN IP4 10.0.1.10
s=Session SDP

c=IN IP4 10.0.1.10

t=0 0

m=audio 49154 RTP/AVP 8 101

a=rtpmap:8 PCMA/8000

a=rtpmap:101 telephone-event/8000

a=fmtp:101 0-15

Following screenshots show an example outgoing call from the enterprise to VVodafone.
e Outgoing INVITE request from the enterprise.

INVITE sip:+1613xxxxx580@61.xxxX.xxx.229 SIP/2.0

Via: SIP/2.0/UDP 10.0.1.10:5060;rport;branch=z9hG4bK7d313b45dcba378c779caecl4abacdef
From: "Extn234" <sip:038xxxxx@61l.xxx.xxx.229>;tag=4dc2d7546038c8c9
To: <sip:+1613xxxxx580@61.xxx.xxXxX.229>

Call-ID: ed4a2f3eb5220e495e77aa42£982428af

CSeqg: 990816612 INVITE

Contact: "Extn234" <sip:038xxxxx@10.0.1.10:5060; transport=udp>
Max-Forwards: 70

Allow: INVITE,ACK,CANCEL,OPTIONS,BYE, INFO,NOTIFY

Content-Type: application/sdp

Supported: timer

User-Agent: IP Office 9.0.2.0 build 860

P-Asserted-Identity: "Extn234" <sip:038xxxxx@10.0.1.10:5060>
Content-Length: 245

v=0

o=UserA 3618421882 3791846658 IN IP4 10.0.1.10

s=Session SDP

c=IN IP4 10.0.1.10

t=0 0

m=audio 49154 RTP/AVP 8 18 101

a=rtpmap:8 PCMA/8000

a=rtpmap:18 G729/8000

a=fmtp:18 annexb=no

a=rtpmap:101 telephone-event/8000

a=fmtp:101 0-15
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e Incoming 2000K response from VVodafone.

SIP/2.0 200 OK

Via: SIP/2.0/UDP 10.0.1.10:5060; rport;branch=z9hG4bK7d313b45dcba378c779caecldabacdef
From: "Extn234" <sip:038xxxxx@61.xxx.xxx.229>;tag=4dc2d7546038c8c9
To: <sip:+1613xxxxx58@61.xxx.xxx.229>;tag=BEDDC954-16A1

Date: Wed, 23 Apr 2014 18:04:29 GMT

Call-ID: ed4a2f3ebb5220e495e77aa42£982428af

CSeqg: 990816612 INVITE

Allow: INVITE, OPTIONS, BYE, CANCEL, ACK, PRACK, REGISTER
Allow-Events: telephone-event

Contact: <sip:+1613xxxxx580@61.xxx.xxx.229:5060>

Supported: replaces

Supported: sdp-anat

Server: Cisco-SIPGateway/I0S-15.2.4.M3

Session-Expires: 1800;refresher=uac

Require: timer

Supported: timer

Content-Type: application/sdp

Content-Disposition: session;handling=required

Content-Length: 253

v=0
o=CiscoSystemsSIP-GW-UserAgent 5094 4509 IN IP4 61.xxx.xxx.229
s=SIP Call

c=IN IP4 61.xxx.xxXX.229

t=0 0

m=audio 23836 RTP/AVP 8 101

c=IN IP4 61.xxx.xxx.229
a=rtpmap:8 PCMA/8000

a=rtpmap:101 telephone-event/8000
a=fmtp:101 0-15

a=ptime:20

8. Conclusion

Vodafone NL SIP Trunking passed the compliance testing. These Application Notes describe the
procedures required to configure the SIP connection between Avaya IP Office and VVodafone NL SIP
Trunking service as shown in Figure 1.

9. Additional References

[1] IP Office 9.0 Installation, Document number 15-601042 Issue 28, 16 April 2014

[2] IP Office 9.0 Manager 9.0, Document number 15-601011 Issue 9.01, 16 Apr 2014

[3] IP Office 9.0 Administering Voicemail Pro, Document number 15-601063 Issue 9.0 Release 1.0,
April 2014

[4] IP Office Embedded Voicemail User Guide (IP Office Mode), Document number 15-604067 Issue
9.0, 16 April 2014

Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP

Office documentation can be found at:

http://marketingtools.avaya.com/knowledgebase/

Product documentation for Vodafone NL SIP Trunking is available from VVodafone Netherlands.
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10. Appendix: SIP Line Template

Avaya IP Office Release 9.0 supports a SIP Line Template (in xml format) that can be created from
an existing configuration and imported into a new installation to simplify configuration procedures

as well as to reduce potential configuration errors.

Not all of the configuration information is included in the SIP Line Template, therefore, it is critical
that the SIP Line configuration be verified/updated after a template has been imported, and
additional configuration be supplemented using Section 5.6.2 in these Application Notes as a

reference.

To create a SIP Line Template from the configuration described in these Application Notes,

configure the parameters as described below.

Use the Windows Registry Editor on the PC where IP Office Manager is installed to add a new
TemplateProvisioning registry entry. Select Start - Run. Enter regedit in the Open box.

= Run

)

== Typethe name of a program, folder, decument, or Internet
resource, and Windows will open it for you.

Open: regedit -

B¢ This task will be created with administrative privileges.

[ OK l | Cancel | | Browse... |

On the Registry Editor, navigate to HKEY _CURRENT_USER - Software - Avaya »>
IP400.Right click on Manager and select New - DWORD Value.

2§ Registry Editor = | 5
File Edit WView Favorites Help
P4 N || MName Type Data -
hilosae ault) REG_SZ {value not set)
Collapse X
S—u = REG_SZ 635338770200932040 |
0 Bl & (= REG_DWORD 0500000001 (1) 1
p ;
|, Softph Ak String Value REG SZ BAK
Classes Delete Binary Value REG_DWORD 000000000 {0)
IEM R DWORD (32-bit) Val REG_SZ 10.0.1.10
cname -0 alue
IM Providi REG_SZ C:\Program Files (x86)\Ava
WORD (54-bit) Value .
Intel Export Q REG_SZ 00007071468 10.0.1.10 ip5C
JavaSoft T e Multi-5tring Value REG_DWORD 000000001 (1)
KVS Expandable String Value REG_SZ SPIPO2
Lenovo Copy Key Name OTPCONFIGOTireOFFSet REG_DWORD 0x00000000 (0)
Macromedia T =E[EOOTPCONFIGL REG_SZ 0000787148 10.0.1.10 ip5C
McAfee = ||| 24 BOOTPCONFIG1 Enabled REG_DWORD 000000001 (1)
Microsoft 26| BOOTPCONFIGLMame REG_SZ SPIPO2
Maozilla 74| BOOTPCONFIGL TimeOffset REG_DWORD 0x00000000 (0)
Netscape _ %4 BOOTPSERVERENabled REG_DWORD 000000000 (0)
Nico Mak Computing ab| BranchAllocationsFile REG_SZ
ODBC ab]| CertificateOffered REG_SZ
Ek'l-°f‘9 24| CLOSECONFIGEnabled REG_DWORD 0x00000001 (1)
p” 't"ets cuit %4 CLOSESAVEEnabled REG_DWORD 000000001 (1)
retEctor surte 2% COMPORTEnabled REG_DWORD 0:00000000 (0) A
Skype S m C
Cocammamdi =

Computer\HKEY_CURREMNT_USER\Softwarel Avaya\IP400% Manager
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Right click the newly created entry and rename it to TemplateProvisioning. Double click the entry
and change the value under Value Data from “0” to “1”. Restart the PC.

Edit DWORD (32-bit) Value (23]

Value name:
TemplateProvisioning

Value data:

Base

@ Hexadecimal

") Decimal

[ ok || Cancel |

To enable template support in the IP Office Manager, select File, then Preferences. On the Visual
Preferences tab, check the Enable Template Options box.

I IP Office Manager Preferences

-7l

| Preferences | Directories | Discovery| Visual Preferences | Security | Validation|
Icon Size [Small v]

[] Multiline Tabs
Enable Template Options

o s [ e ]
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To create a SIP Line Template from the configuration, on the left Navigation Pane, right click the
Sip Line (17), and select Generate SIP Trunk Template. Note that the Generate SIP Trunk
Template is only presented when the TemplateProvisioning key created in the PC where the IP

office Manager installed.

2o Contral nit 41
mn |

g [

1

IP Offices [ Line = SIP Line - Line 17 ek - XK v <>
& gooTP (2) » | Line Number Line Type Line SubType ‘ SIP Line [Transport | SIP URI|VolP | T38 Fax|SIP Credential]
4+ Operator (3) R Y7 SIP Ligem " , L
SPIpO2 18 spLj A N v = B
20 Systern (1) sl
47 Line (@) : 19 SIP Ll|j Generate SIP Trunk Template | ame In Servic
“= Control Unit (4) 20 SIP L cut CtrleX
4 Extension (39) ? Y ™ URI Type
a User (38) 53 Copy Ctrl+C
5§ Group (1) = Paste Ctrl+V Check O
@M Short Code (73) . L
D Service () 75 Delete Ctrl+Del 0 Call Rowl &
ally RAS (1) " Validate Originat|
g I‘.I\n"mr;i:tg(ﬂc)a” Route (3 Connect To... Ctrl+T forwarde
anrFo
.o Directory (0) Mew from Template (Binary) refix 00 MName P
£ Time Profile (0) Export as Template (Binary)
D) Firewall Profile (1) — [Mone -] calerm
-l IP Route (2) Show In Groups i
.8 Account Code (0) ethod [By Source IP address '] Send Fro
. License (29) Customize Columns...
3 User-Agi
& Tunnel (0) Headergs
- User Rights (8)
il Auto Attendant (0) Service E
g ARS (2) .
- Location (0) Action o
E-#% 5PIPO2 necen ~
2 Systemn (1) d Ul C
9 Line (4)

Ready P
The trunk’s settings are displayed as configured in Section 5.6.2 Enter a descriptive name for the
template, adjust the settings if required, and then click on Export.
57/ SIP Trunk Template - (SIP Trunk - 17) (23]
Please review and change the trunk settings if you want -
SIP Line | Transport | VoIP | T38 Fax | SIP Credentials |
Descriptive Name Vodafone| URI Type [S|P v]
ITSP Domain Name Check 005
Send Caller ID [None ~|  Call Routing Method [Request URI ~|
Association Method [By Source |P address V] gﬁ:ﬁg&gﬁg?z‘};ﬁ?ﬂg calls
MName Priority [System Default V]
Incoming [Pd.rto V]
Outgoing [Pd.rto V]
UPDATE Supported [Ne\rer V] Caller 1D from From header
User-Agent and Server Headers Send From In Clear =
Export ] [ Cancel
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On the next screen, Template Type Selection, select the Country, enter the name for the Service

Provider, and click Generate Template.

W] Template Type Selection EI [=] @
Locale United States (LIS English]
Courntry Metherands - I
Service Provider Vodafone -
IGenameTémmme] I Cancel I

The following is the exported SIP Line Template file NL_Vodafone_SIPTrunk.xml.

<?xml version="1.0" encoding="utf-8"?>

<Template xmlns="urn:SIPTrunk-schema">
<TemplateType>SIPTrunk</TemplateType>
<Version>20140423</Version>
<SystemLocale>enu</SystemLocale>
<DescriptiveName>Vodafone</DescriptiveName>
<ITSPDomainName> </ITSPDomainName>
<SendCallerID>CallerIDNone</SendCallerID>
<ReferSupport>true</ReferSupport>
<ReferSupportIncoming>2</ReferSupportIncoming>
<ReferSupportOutgoing>2</ReferSupportOutgoing>
<RegistrationRequired>false</RegistrationRequired>
<UseTelURI>false</UseTelURI>
<Check00S>true</Check00S>
<CallRoutingMethod>1</CallRoutingMethod>
<OriginatorNumber />
<AssociationMethod>SourceIP</AssociationMethod>
<LineNamePriority>SystemDefault</LineNamePriority>
<UpdateSupport>UpdateNever</UpdateSupport>
<URIType>SIPURI</URIType>
<UserAgentServerHeader />
<CallerIDfromFromheader>true</CallerIDfromFromheader>
<PerformUserLevelPrivacy>false</PerformUserLevelPrivacy>
<ITSPProxy>62.xxx.xxXx.229</ITSPProxy>
<LayerFourProtocol>SipUDP</LayerFourProtocol>
<SendPort>5060</SendPort>
<ListenPort>5060</ListenPort>
<DNSServerOne>0.0.0.0</DNSServerOne>
<DNSServerTwo>0.0.0.0</DNSServerTwo>
<CallsRouteViaRegistrar>true</CallsRouteViaRegistrar>
<SeparateRegistrar />
<CompressionMode>AUTOSELECT</CompressionMode>
<UseAdvVoiceCodecPrefs>true</UseAdvVoiceCodecPrefs>
<AdvCodecPref>G.711 ALAW 64K,G.729(a) 8K CS-ACELP</AdvCodecPref>
<CallInitiationTimeout>30</CallInitiationTimeout>
<DTMFSupport>DTMF SUPPORT RFC2833</DTMFSupport>
<VoipSilenceSupression>false</VoipSilenceSupression>
<ReinviteSupported>true</ReinviteSupported>
<FaxTransportSupport>FOIP T38FB</FaxTransportSupport>
<UseOffererPrefferedCodec>false</UseOffererPrefferedCodec>
<CodecLockdown>false</CodecLockdown>
<Rell00Supported>false</Rell00Supported>
<T38FaxVersion>1</T38FaxVersion>
<Transport>UDPTL</Transport>
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<LowSpeed>0</LowSpeed>
<HighSpeed>0</HighSpeed>
<TCFMethod>Trans_TCF</TCFMethod>
<MaxBitRate>FaxRate 14400</MaxBitRate>
<EflagStartTimer>2600</EflagStartTimer>
<EflagStopTimer>2300</EflagStopTimer>
<UseDefaultValues>false</UseDefaultValues>
<ScanLineFixup>true</ScanLineFixup>
<TFOPEnhancement>true</TFOPEnhancement>
<DisableT30ECM>false</DisableT30ECM>
<DisableEflagsForFirstDIS>false</DisableEflagsForFirstDIS>
<DisableT30MRCompression>false</DisableT30MRCompression>
<NSFOverride>false</NSFOverride>

</Template>

To import the template into a new IP Office system, copy and paste the exported xml template file
into the Templates directory (C:\Program Files\Avaya\lP Office\Manager\Templates) on the PC
where IP Office Manager for the new system is running.

Next, import the template into the new IP Office system by creating a new SIP Line as shown in the
screenshot below. In the Navigation Pane on the left, right-click on Line then navigate to New, New
SIP Trunk From Template:

IP Offices | Line = SIP Line - Line 17 e - X[ v <>
& BOOTP (2) BN \ineblumbed glicejlype] jlineSublype SIP Line Transport [sIP URI|VolP [ 138 Fax|SIP Credentiald
i Operator (3) 17 SIP Line -
p =
New v H323 Line v =
Generate SIP Trunk Template IP DECT Line ame In Servic
SIP Li
cut Ctri+X ine URI Type
SM Line
Copy Ctrl+C
_ SIP DECT Line Check O
Paste Ctrl+V
| 2¢  Delete R Mew SIP Trunk From Template 0 Call Rou|E
B validate Originat
@ Inco Country Code f
= = orwarde|
- §F) Wan Connect To... Ctrl+T
;'f'\ Direq Mew from Template (Binary) International Prefix 0o Mame Pr
£17 Time
@ Firew Export as Template (Binary) Send CallerID [Mone ~]  caler
1l IP Rol
.4 Acca phowlnGloups Association Method [By Source IP address v] Send Fro
e Licer Customize Columns... User-Ag:
& Tunrteryoy Headers
--§i5 User Rights (8)
gl Auto Attendant (0) Service E
¢ ARS (2)
5@ Location (0) Action o
P IPO2 =l nreene S
! System (1) 4 I v

On the next screen, Template Type Selection, verify that the information in the Country and
Service Provider fields is correct. If more than one template is present, use the drop-down menus to
select the required template. Click Create new SIP Trunk to finish the process.

I”| Template Type Selection

=N ROR| =5

Locale United States (US English)

| Netherlands

-

Country

Service Provider [Vadafane

v] [ Display &1

[ Create new SIP Trunk ] [ Cancel
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Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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